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1 Product Description

1.1 Overview

The WS2000 SSMATE is a software and hardware bundle that will
allow GPI (General Purpose Interface) control of any function of the
network element enabling either manual or automated control.

The functionality of the SSMATE is limited to monitoring the 32
discrete inputs and issuing a unique ASCII text command string from 1
to 5 serial output ports. Discrete inputs, command string content and
output port associations are user definable in the configuration process.

Figure 1-1 WS2000 SSMATE Front Panel

The SSMATE feature set and capacity capabilities are:

32 Discrete Inputs

5 RS-232/RS-422/RS-485 serial ports for transmitting user-defined
ASCII command strings

1 RS-232 craft port for configuring the SSMATE either through an
ASCII terminal or using the supplied PC based configuration
software package

Up to 5 string records each containing a maximum length of 45
characters, described as a “text block”, can be individually
associated with each of the 32 discrete inputs

Configuration files can be uploaded and downloaded from the
SSMATE craft port to the user’s PC.

Each configuration change can be individually downloaded to the
SSMATE rather than downloading the entire configuration.
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1.2 WS2000 SSMATE Configurations and optional
equipment
Table 1-1 lists part numbers for ordering the WS2000 SSMATE,
accessories, and spares.
Table 1-1  WS2000 SSMATE Equipment Part Numbers
WS2000
Part No Plugin Description Serial Ports Discrete /O M_I(_)dem
Input | Output | 'YP®

590-T325 500-T191 SSMATE 5 HOST, 1 CRAFT 32 -
Accessories

567-T060 - SSMATE Configuration Software — — -
533-T030 - 19-inch Telzon Wire-Wrap Block 64 16 -
533-T011 - 23-inch Telzon Wire-Wrap Block 64 16 -
533-T032 - Front-Access Wire-Wrap Interface Assy 64 16 -
585-T034 - Rear-Access Wire-Wrap Interface Assy 64 16 -
520-T007 - Audible/Visual Alarm Panel (Monitors one RTU) — _ -
520-T025 - Universal External Alarm Panel (Monitors eight RTUs) — _ -
620-0077 - 8-Pin Serial Connector (Ten are included in 585-0005) — — -
620-0078 - 50-Pin Delta Connector - - -
620-T030 - 50-Pin Delta Connector w/Wire-Wrap pins. - - -
990-0150 - Serial Insertion Tool (One is included in 585-0005) - - -
977-T032 - Cable, PC-WESMAINT, DEB9-DB25 - - -
977-T042 - JB3 Termination Plug - - -
585-0005 - Serial Connector Kit (Includes 12 connectors, one tool) — _ -
500-2000 - 19-inch Shelf Assembly — _ -
585-T055 - 23-inch Rack Adapter Kit — — -
994-T059 - WS2000 SSMATE Technical Manual — — -
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1.3 Other Products From Westronic

131 WS1000

1.3.2 C1000

S rr rrr P
AN A B B B B B B B |
e - - -

The following provides information about other Westronic products that
are available to meet alarm system needs. Call 972-235-5292 to talk
with a Westronic representative to learn more about these and other
Westronic Systems, Inc. products.

The WS1000 product line complements many operations and network
management systems by providing an economical, flexible means of
converting varying quantities of discrete (dry-contact) alarm, status, and
control data to a simple, easy-to-handle TABS or TBOS interface.

Available configurations provide the flexibility to select the unit best
suited for various applications. Choose 64/128 discrete inputs with 8/16
discrete outputs.

Small size and flexible mounting requirements allow placement of the
unit close to the source of discrete interfaces. WS1000 can mount in an
equipment bay or on a distribution frame as the application demands.
This flexibility results in considerable reduction in the amount of
required wiring. The basic structure of a front-facing wire-wrap block,
commonly found on distribution frames, provides a sturdy housing for
the Terminator. Located on the easily removable module contained
within the housing are all the active components. WS1000 is the ideal
way to collect discrete alarms throughout a site or service area with
feeDBack to a WS2000 or WS3000 hub.

The C1000 complements many operation support systems by providing
an economical and flexible means of collecting small to large quantities
(32 — 256 points) of discrete alarm and status data and converting them
to simple, easy-to-handle TABS or TBOS interface.

| . |
LI

vl Different versions of the C1000 allow

— communications with either a TABS or TBOS host.
The C1000 can pass-through polls for other
addresses, permitting multiple chaining of C1000
units in larger configurations and permitting the C1000 and local NE
telemetry data to combine into a single channel. In some cases, data can

combine through a single modem.

The C1000 requires only one vertical space (1.75 inch) in either a
19-inch or 23-inch equipment rack, allowing location as close as
possible to the source of discrete interfaces. The result is a large
reduction in the amount of wiring required to pick up alarm and status
data. The reduction in wiring eliminates the possibility of losing data

994-T059 Rev March, 2006
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1.3.3 WS3000

through unknown, disconnected, moved, or cut wiring. Serial and
discrete interfaces are through standard 9-pin subminiature and 50-pin
connectors, making installation and replacement exceptionally fast and
simple.

The C1000 is equipped with two serial ports:

The first, a host port, serves as a TABS or TBOS host
communications interface that can be equipped with an optional
1200-bps Bell 202T-compatible internal modem, allowing the
C1000 to be located beyond the range of standard RS-422/RS-485
interfaces.

The second, an expansion port, serves as a TABS or TBOS data
collection interface.

The housing can accommodate a maximum of eight 50-pin discrete
interface connectors. All the different configurations use this same
housing.

The WS3000 is a powerful telemetry unit that combines a high-speed
processor and large database capacity with the most useful functions of
discrete and serial alarm collection, mediation, and access. The WS3000

is the ideal bridge between today’s telemetry
networks and the advanced protocols now
appearing. WS3000 features include the following:

e Optional
Ethernet interface

Available solutions for remote alarm monitoring over TL1 (ASCII)
TCP/IP Ethernet, OSI Ethernet, and asynchronous communications

Data collection using TBOS, TABS, and Teltrac protocols and
discrete dry contacts

5 serial ports supporting user-selectable RS-232/RS-422/RS-485
interfaces from 1200 — 9600 bps

4 serial ports supporting RS-422 interfaces from 1200 — 9600 bps

32 — 512 discrete alarm/status inputs and 8 — 128 discrete control
outputs with capability to support a maximum of 30,000 alarm
points (about 2,000 SIDs)

Remote database configuration and software upgrade through
exchanging PCMCIA cards or downloading through a Trivial File
Transfer Protocol (TFTP) server or X-modem

Switched Network Software (SNS, also referred to as String TABS)
to control network access devices, such as PADs, terminal servers,
and modems, for monitoring network elements and remotes

994-T059 Rev March, 2006

Product Description 1-5



e Fault-Tolerant Monitor (FTM, also referred to as TABS2) software
to provide redundant 2-way monitoring of long-distance network
elements

e Custom protocols are available on a special assembly basis

1.34 WS1500 e-Scanner

Designed to meet NEBS Level 3 testing, the WS1500 e-Scanner

augments Westronic’s current product line by adding an economically

priced product to collect smaller point counts and interface with SNMP
networks.

Westronic Systems products have traditionally
focused on collecting and concentrating large
amounts of discrete and serial alarm data into
TABS, E2A or TL1 protocols. The initial WS1500 offering includes 32
discrete collection point remote with a TCP/IP interface capable of
communicating to the host via SNMP. This unit provides 4, Form-C
control outputs with common wiper for wetted voltage applications.
Front panel visual indicators instantly report active alarms and controls
as well as MPU and IP activity. Compact in size, the WS1500 takes
only 1 VU rack height (1.75”). Hardware is included for 19” or 23”
rack or optional wall-mount installations.

The WS1500 e-Scanner is configured locally or remotely using a
VT100, SNMP, or Telnet session. Remote configuration and upgrade
capabilities ensures the WS1500 features will evolve with market
demands. The configuration is stored in non-volatile memory and can
be updated "on the fly". Simplicity in configuration and ease of use
mean low cost to install and maintain.

1.35 WS3500 Metago

WS3500 Metago intelligent remote telemetry unit is certified to NEBS
Level 3 testing requirements by NTSC. The WS3500
Metago augments Westronic’s current product line by
adding a NEBS 3 product to collect serial and
discrete telemetry information while interfacing with
industry standard management systems via TL1
(Transaction Language 1). The WS3500 offering is
modular in design allowing customers to configure a unit to their
specific collection requirements. Available configurations include
from 0 to 512 discrete inputs, 128 analog inputs, and up to 24 serial
ports, which can be configured as RS-422/485 or RS-232. Reporting to
host management systems can be accomplished via RS-232, modems,
TCP/IP and CDPD. Front panel visual indicators instantly report active
controls as well as MPU and network activity. Additionally, with an

994-T059 Rev March, 2006
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integrated web-server, status of the alarms and controls may be viewed
with any web browser. Compact in size, the WS3500 takes only 4 VU
rack units and hardware is included for 19” and 23” mounting. Remote
configuration and upgrade capabilities ensures the WS3500 features
will evolve with market demands. The configuration is stored in non-
volatile memory and can be updated "on the fly". Simplicity in
configuration and ease of use means low cost to install and maintain.

1.3.6 1:7 Digitial Bridge

The Westronic Digital Bridge is an ideal solution for achieving all-
digital datacom networks. It allows you to deploy multi-point
asynchronous networks, including telemetry and
data acquisition. It eliminates the complexity of
analog equipment such as modems, data station
terminations and analog bridges. As a result,
bandwidth is freed, speeds are improved and
maintenance is reduced throughout your telemetry network.

The Westronic Digital Bridge broadcasts host system polls to all
stations, routing the one responding station back to the host. In peer-to-
peer applications, any message from a station on the bridge is replicated
to all other stations in the network.

1.3.7 Dual/Quad Modem

The Westronic Dual and Quad Modems are an effective way to connect
telemetry equipment to analog facilities. Created specifically for central
office telecommunlcatlons applications, the unit’s simple, low

R maintenance design ensures trouble free operation.

User-selectable digital interfaces configurable for
RS-232, RS-422 or RS-485 separate the Westronic
Quad Modem from its competitors in the
telecommunications industry. The RS-485 option permits a single
remote telemetry unit or collection port to connect up to 32 modems.
This configuration allows each remote site to operate in a point-to-point
arrangement, thus eliminating troublesome analog bridges.
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2 Hardware Description

2.1 Front-Panel Indicators and Controls

Figure 2-1 is an illustration of the WS2000 front panel, showing the
location of the front-panel indicators and controls.

°
RTS X DCD RX
© o o o 0000000000000000 0000000000 000000
e Cgs RN 0000000000000000 4 OO00000000000000 (@)
' Lamp Test
RTS TX DCD RX
o O O O
cos COS MPU
RST RUN
o O
33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64
O000O0O0O0O0O0O0OOOOOO OOOOLOLOLOOOOOOOOOO
12 3 45 6 7 8 9 10111213 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32
O0000O000O0O0OOOOLOO OOOLOLOLOOOOOOOOOO
Cl 2 3 4 56 7 8)
Figure 2-1  WS2000 Front Panel

When the WS2000 detects a new alarm, it lights the front-panel LED
for the associated alarmed input (1 — 32) and activates the COS relay,
which lights the cos LED. The front-panel alarm LED, the cos LED,
and the COS relay remain active. At this point, this is an
unacknowledged alarm.

However, you can acknowledge the new alarm or multiple unacknowl-
edged alarms by pressing the COS RST pushbutton or an external push-
button that temporarily grounds the COS Reset terminal on TB1. The
COS relay then deactivates and extinguishes the Cos LED, but the
front-panel LED for the alarmed inputs (1 — 32) remains lit until the
alarms clear.

If the COS relay outputs on TB1 drive an external audible device, the
device will sound following an alarmed input until the alarm is
acknowledged by pressing the COS RST pushbutton.

Any new alarm detected after you release the COS RST pushbutton reac-
tivates the COS relay, cOs LED, and the external audible device, if
connected.
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2.1.1 Indicators

Table 2-1 Front Panel Indicators

Indicator Title Function
Microprocessor Run Indicates proper initialization and operation of
MPU RUN LED P microcomputer and real-time operating system
software. Failure indicated if "Off"
Indicates input (serial/discrete) change-of-state
cOS Change-of-State (alarm). The cos LED mirrors the state of the COS
LED relay (Figure 3-10): lit when the relay is activated
and extinguished when the relay is deactivated.
Alarm present on point (1-32). LED's 25-32 are
STATUS/ALARM Input Indications indications for control outputs 1-8 if backplane
LED (1-32) : e
jumper Z7 is installed
I Alarm present on point (33-64). LED's 57-64 are
STATUS/ALARM Input Indications indications for control outputs 9-16 if backplane
LED (33-64) (NOT USED ON SSMATE) | . L.
jumper Z9 is installed
RTS Request-To-Send Carrier Output
TX Transmit Transmit data indication
DCD Data Carrier Detect | Carrier Frequency Received
RX Receive Receive data indication

2.1.2 Pushbuttons

Table 2-2 Front Panel Pushbuttons

Button Title Function
COS RST Change-of-State Reset COS LED and central office alarm
Reset annunciator (ACO)
LT Lamp Test Lights all Status/Alarm LEDs

WS2000 has the following front-panel pushbuttons:

COS RST — Change-of-State Reset — Resets the COS relay (Figure 3-10)
and extinguishes the cos LED to acknowledge an alarm condition on
serial/discrete inputs to the WS2000.

LT — Lamp Test — Lights all Status/Alarm LEDs.
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2.2 Interfaces

2.2.1 Discrete Interfaces

The WS2000 SSMATE senses 32 status/alarm inputs. The front panel
LEDs indicate the status of the individual input.

The WS2000 32/8 is equipped with 8 Control Output relay closures.
These Control outputs are inactive when the WS2000 SSMATE
software is installed.

2.2.2 Serial Interfaces
The WS2000 SSMATE comes equipped with six serial ports:

e Channel 0 (Craft) supports Asynchronous communications using
RS-232 interface. Factory settings are 9600, 8-data bits, no parity
and 1 stop bit. There is no provision for the user to change the Craft
port parameters in the SSMATE application.

e Channels 1-5 are configurable RS-232/RS-422/RS-485 serial ports
for transmitting user-defined ASCII command strings. Each
channel is configurable can be configured with the following

selectable parameters:
Speed: 1200, 2400, 4800 and 9600 bps.

Data Bits: 7o0r8
Parity: Even, Odd or none
Stop bits: 1 or?2

Service: RS-232, RS-422 or RS-485

2.3 Configuration and Diagnostics

The Craft port, channel 0, is used for making all configuration changes
to the SSMATE unit. The craft port is accessible through the DB-25 D-
subminiature connector (JB3) located on the front panel of the WS2000.

2.4 Specifications

This section provides detailed information on the electrical,
environmental, and mechanical specifications of the WS2000 product
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T
line. Also included are detailed data for the parallel, serial, and host
ports, and auxiliary interfaces.

2.4.1 Electrical
The following are typical power and electrical requirements:

Input voltage range: —20 Vdc to —60 Vdc

Power requirements:
e 5.0 Watts (No input sense currents)
e 24.0 Watts (64 inputs sense currents)
Fusing of WS2000 units: See Table 3-6.
External switching power available from the WS2000 unit
WS2000 supply outputs:
e +5.0Vdc+5% at 1.5 Amps (maximum)
e +12.0 Vdc + 10% at 400 mA each (maximum)
e 12.0 Watts total output power

2.4.2 Environmental

e Operating ambient temperature range: 0° C to +55° C
e Humidity: < 95% noncondensing

2.4.3 Mechanical

The following lists WS2000 mechanical characteristics:

Dimensions

e Height: 1.75 inches (4.4 cm)

e Width: 17.4 inches (44.1 cm)

e Depth: 8.0 inches (20.3 cm)
Mounting

e 19-inch (48.3 cm) rack mounting

e 23-inch (58.4 cm) rack mounting with optional adapters
Weight

e 5.3 1bs (2.4 kg) maximum unpackaged; 8 Ibs (3.6 kg) packaged
Connectors

e Power, analog, and auxiliary connections: TB1
14-pin, dual-level compression terminal block that accepts #14 to
#24 AWG wire
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e Serial and digital host port connections: P1 — P6, P8 — P13
eight-position header terminal connectors. Mating connectors man-
ufactured by:

e  Methode: PN 1300-108-424 or PN 130F-108-424
e  Westronic: PN 620-0077 or PN 690-T006/690-T007

e WPIB connection: P7 (not used)
34-position (2 x 17) ribbon cable header. Mating connector manu-
factured by:

e  Amp: PN 746094-8
e Robinson Nugent: PN IDS-C34PK-SR-TR
e Assmann: PN AWP 34-7241

e Discrete connections: J1, J2
50-position, female, Delta-type connectors. Mating connector man-
ufactured by:

e TRW: PN 97-12500-180 or PN 97-12500-181
e  Westronic: PN 620-0078

2.4.4 Interfaces

This section provides detailed data on each of the WS2000 interfaces.

24.4.1 Serial Ports

Serial Output Channels 1-5

e Asynchronous Communications:
1200, 2400, 4800, or 9600 bps (9600 is default)

7 or 8 data-bit characters (8 is default)
Even, Odd or No parity (None is default)
1 or 2 stop bits (1 is default)

RS-232/RS-422/RS-485 selectable (RS-232 is default)

e Connectors:
Channel 1 P12 (RS-232), P6 (RS-422) and P13 (RS-485)

Channel 2 P4 (RS-232/RS-422/RS-485)
Channel 3 P11 (RS-232/RS-422/RS-485)

Channel 4 P3 (RS-232/RS-422/RS-485)
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Channel 5 P10 (RS-232/RS-422/RS-485)

Configurator (Craft) Channel 0

e Asynchronous Communications:
Factory set to RS-232, 9600bps, 8-data bits, no parity and 1 stop bit.

e Connectors:
Use only one connector concurrently.

P5 (rear)
JB3 (front-access DB25)
e Prog En (Program Enable/EEPROM Write Enable)
P5 (rear) Strap P5 pins 3t0 6
JB3 (front-access DB25) Strap JB3 pins 18 to 25.
2.4.4.2 Alarm Sensor Inputs

e 32 photo-coupled inputs arranged in groups of eight with a single
common for all inputs

e Input voltage: —48 Vdc Battery, (+) Battery Return
e Input current: 3 -5 mA for each point
e Logic levels:

Input Logic Voltage
Power Level

-48 Vdc 0 (Off)  Input open or —40 Vdc to —60 Vdc
1(On) Input greater than —12.0 VVdc
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3 Installation

3.1 Overview

3.2 Handling

This section contains detailed installation instructions, tables, and dia-
grams that define all hardware configuration options, special material
handling considerations, and precautions. Included are descriptions of
the physical layout of the unit and optional equipment. Not all
hardware, connections, wiring, and strapping are applicable to all
WS2000 versions or applications.

Considerations and Precautions

WS2000 modules contain Complementary Metal-Oxide Semiconductor
(CMOS) and N-Channel Metal Oxide Semiconductor (NMOS) inte-
grated circuits to maximize noise immunity and promote low power
consumption. These components are Electro-Static Discharge (ESD)
sensitive and can be damaged if subjected to high static voltage levels.
Therefore, ensure familiarization with the ESD procedures that follow.
Packaging containing CMOS and NMOS components has a label as

shown in Figure 3-1.

Static Sensitive
Maintain Antistatic Protection

Figure 3-1  Electrostatic Discharge (ESD) Label

CMOS and NMOS devices are equipped with protection diodes, but
incorrect handling that allows excessive static energy to enter the
devices can still cause device failure. These failures are not readily
detected and, in time, can lead to premature device failure.

Adhering to the following guidelines significantly reduces the possibil-
ity of electrostatic damage on CMOS or NMOS components, thus
improving system reliability and keeping downtime to a minimum:
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Before removing or inserting modules, always verify they
are not carrying static charges. Always wear a personal
grounding device, such as an ESD heel or wrist strap.

When extracting a module, always place it in an antistatic
bag or covering for transportation/storage.

Perform repair work on modules in an antistatic
workstation. All personnel performing repair work must be
grounded through wrist straps and antistatic matting in the
workstation.

Exercise extreme care when handling CMOS/NMOS
components. Do not touch the pins and always place
components in antistatic foam for storage and
transportation.

Ensure that desoldering tools have static reduction. Some
desoldering tools can actually generate large static voltages
that damage CMOS and NMOS devices.

3.3 Module Substitution

The following are general procedures that must be followed when
replacing or substituting WS2000 modules:

Turn power off when removing or inserting modules. The
boards are designed to withstand removal and insertion
with power on, but a highly recommended practice is to
remove the system power when substituting modules.

Make sure the substitute board is of the same type (part
number) and contains the same options.

Substitute modules only with modules that contain identical
jumper connections. Observe the jJumper and mini-jumper
arrangements on the original board and ensure they are
identical on the replacement module. Failure to do so can
cause module failure, point displacement because of
incorrect board addresses, communication failure with the
host, and other related failures.

Make sure an EEPROM with current firmware is installed
on the replacement board. Always make sure that substitute
or replacement EEPROMSs are properly seated in the socket
with correct pin alignment. Verify that all pins insert into
the socket and none are bent inward/outward.

Make sure replacement modules mate properly with the
connectors at the rear of the bin. Never force a board into
position because this can damage rear connectors. In case
of insertion problems, determine why the module does not
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easily plug into position and take appropriate action. To
plug a module into position, push firmly with the thumbs
on the lower portion of the front. Remove a module by
gently rocking it while drawing it from the bin until it is
free of the connectors at the rear.

Only qualified electronics service personnel who are familiar with
microcomputers and Input/Output (1/0) interfacing should carry out
actual module repair. Attendance by such personnel in a WS2000 train-
ing course to learn special circuit concepts and applications is highly
recommended. When returning a faulty module, describe the suspected
problem, fault, or symptom on the documentation that accompanies the
module.

34 Installation Procedures

The following describes how to install the WS2000 and ancillary prod-
ucts into a permanent location. Refer to the checklist at the end of this
section for a step-by-step WS2000 installation guide. After you work
through the installation steps, the WS2000 unit is ready for software
configuration. Refer to Sections Error! Reference source not found.
and 4 for these procedures.

3.4.1 Inspecting the WS2000

Before applying power, remove the WS2000 main board assembly from
it’s housing and confirm that the plug-in expansion boards are seated
properly. Strap options are preset in the factory, however, they can be
changed according to user requirements.

3.4.2 Installing the WS2000

The WS2000 requires one vertical space (1.75 inches) in a 19-inch stan-
dard telecommunications rack. Rack adapters are included with the unit
for mounting in 23-inch wide racks. Figure 3-2 shows the various
dimensions for the WS2000, which are the same for discrete expander
units.
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1.75"
Figure 3-2
3.4.3
3.4.3.1

i

Total depth is approximately 9.5 inches, including
front panel handles and rear connector block TB1.

00
@
Y

WS2000 SSMATE

Configuring the WS2000

The following presents strap options for the main board, internal
modem boards, and the backplane. Consider in all cases that the internal
modem is not used. Option straps on the main board determine the
following:

e  Source of Channel 1 RTS and TX signals

e  Memory size (8K or 32K) and type (EPROM, EEPROM,
or RAM), Write Enable for EEPROM, and address range
for RAM

e  Device size (28/32 pins)
e  Watchdog enabled/disabled
e  Memory bank switching

The backplane option straps establish the serial port receive side ter-
minations when operating RS-422 or RS-485.

Main Board

With over 13,000 installations of the WS2000 worldwide, a typical
WS2000 manual must cover main board iterations manufactured since
1991. The normal E2A, TABS and TBOS WS2000 manuals refers to
four main boards (referred to as Type 1, Type 2, Type 3, and Type 4)
being available. The WS2000 SSMATE is manufactured using the latest
Type 4 (revision 12) main board.

Note: All strap options are preset at the factory.
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This applies to PCB PN 820-0140, Rev 12
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B3 skl B2

= 00000000000
J

UB26

Figure 3-3  Strap Arrangements for Type 4 main Board

Table 3-1  Strap Arrangements for Type 4 Main Board

Block Pin Function

Channel 1 RTS (modem) from Main board.

Remove when daughter board provides source.
WB1

Channel 1 Tx (modem) from Main board.
Remove when daughter board provides source.

Do Not Install. UB24 RAM address range
Do Not Install. UB24 RAM address range

WB2

1-6
2-5
3-4 | Write enable when UB25 is EEPROM
1-2 | UB26 is 32-pin device.

2 -3 | UB26 is 28-pin device; Default (Note).

WB3

WC1 | Not Used | Board ID

None | Watch Dog Enabled (Auto Restart)
1-2 | Watch Dog Disabled

ZB1

7ZB4 1-2 | Not Applicable
ZB8 | _3 |UB25/UB26 bank switchable; Default
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Table 3-1  Strap Arrangements for Type 4 Main Board

Block Pin Function

ZB3 None | For Testing Purposes

Note: When UB26 is a 28-pin device, insert it in the pins closest to the
front of the board.

3.4.3.2 Backplane

Figure 3-4 shows the location of the discrete input point connectors

(J1), the serial port connectors (P1 — P6, P8 — P13), and option jumper
blocks Z1 — Z9.

Discrete Points

J2 J1 P7

33
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34
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Interface Bus

Serial Ports
P7 P6 P5 P4 P3 P2

12345678|(12345678[|112345678]|/12345678 345678 . O—, O 14

1 IOOOOOOO IOOOOOOO IOOOOOOO IOOOOOO OOOOO IOOOOOOO O 2
G000000000N o 3

(o) o O 4q
2 IOOOOOOO IOOOOOOO IOOOOOOO IOOOOOOO IOOOOOOO IOOOOOOO o oo O o 5
O 7

——————— P13 P12 —_—— Pll - P1 P9 --——- P8 - o oo [——
oooooooomt o OO0cCveveww O0Coceowoev O uuuuu O00Cc v m- O 9

o0000000m O O o OOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOI O 10
oo0o00000m o OOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOI o{to o) O 11

———————— 0o —_—_——,————,e e — e e ——— ——— 0o 12
)il 000 18889 W50500l 8060 o — ']
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Figure 3-4  WS2000 Backplane

3.4.3.2.1 Serial Output Port Terminations

Applications using RS-232 interface operation require no straps on
jumper blocks Z2 and Z3.

If a connected port uses RS-422 or RS-485 interface operation, the port
interface requires termination resistors (180Q) on the receive side.
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Table 3-2

3.4.4

Install the appropriate jumper straps on blocks Z2 and Z3 to provide
termination resistors for Channels 1-5. Table 3-2 lists the jumper strap
arrangements for blocks Z2 and Z3.

Recommendation: Install terminating resistors on the receiver terminal
of all RS-422 circuits and on the furthest receiver terminal of an RS-485
circuit.

Z2, 73 Jumper Strap Arrangements for RS-422/RS-485 Receiver Termination

Strap Function
Pins 72 Z3 (Note)

1-8 Chan2Rx | Chan1CTS

2_7 Chan3Rx | Chan 1 Rx

3-6 Chan4 Rx | Chan1RxC

4-5 Chan 5 Rx Chan 1 TxC

1-4 N/A Chan 1 CTS

2-3 N/A Chan 1 Rx

Cabling the WS2000

Figure 3-4, a rear view of the WS2000 unit, shows how the connections
are grouped on the WS2000 backplane. This section provides
connection details for cabling the WS2000 to the network and office
equipment in the following order (the order is not critical; vary accord-
ing to your needs/optional equipment):

e  Make all RS-232/RS-422/RS-485 serial connections to
channels 1-5 using eight-pin Methode connectors wired
according to Table 3-4.

e  Connect discrete inputs 1-32 and through 50-pin connector
J1 found in Table 3-5.

e  Make power and local annunciator (if used) connections at
TBL1. See Figure 3-10

e  Connect optional accessory interface equipment, such as
the Telzon termination panel, the front-access wire-wrap
kit, or the rear-access wire-wrap Kit.

. Note: The front-access wire-wrap kit handles serial port,
discrete input/control output, and TB1 connections. The rear-
access wire-wrap kit and the Telzon termination block handle
serial port and discrete input/control output connections.
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3.4.4.1 Front-Panel Craft Port

Pinout information and pin layout for the front-panel DB25 Craft port
connector (JB3) appears in Figure 3-5.

—-12 Vdc +12Vdc Com Rx TX

o e 100010000000 o
AOOROORDOOD®

Prog En +5 Vdc

Female DB25 Connector (DCE)

Figure 3-5 Front-Panel Connector JB3

Pins 18-25 must be connected to enable writing to the WS2000
memory. The Wesmaint cable 977-T032 has this jumper in place.

Table 3-3 Front-Panel Wesmaint Connector JB3

Pin Function

2 Transmit

3 Receive

7 Common

11 +12 Vdc
13 -12 Vvdc
18 +5 Vdc

25 Program Write Enable

3.4.4.2 SSMATE Configurator Connections

Connection of a PC to the WS2000 SSMATE requires the PC cable
(977-T032) included with the software package (567-T060). Connect
the cable to the PC COM1 (Factory Set). If the PC uses a 25-pin COM
port, use the supplied DE9 to DB25 adapter to adapt the cable to the
COM port. If the application requires an extension cable, use a standard
RS-232 cable to connect the cable to the WS2000 SSMATE.

994-T059 Rev March, 2006

Installation 3-8



3.4.43 Serial Port Connections

Serial port cable assemblies use the supplied Methode IDC connectors
(PN1300-108-424 or 30F-108-424 or Westronic PN 620-0077). The
Methode hand insertion tool, JT-11-100-ST (Westronic PN 990-0150),
is also supplied to assemble the required cables.

Each serial cable must be fitted with a ferrite Electromagnetic Interfer-
ence (EMI) filter (provided with each WS2000) during installation. The
cable must wrap a minimum of two times around the ferrite and snap
securely shut.

CAUTION: The Methode connectors are designed for #24 AWG solid
wiring. Use of smaller or larger diameter wiring, multiple terminations
in the same contact, or stranded wire can result in intermittent
connections.

Figure 3-6 illustrates the portion of the backplane containing the serial
port connectors. The figure shows the port locations, their channel asso-
ciations, the pin designations, and the type of serial interface.

The serial output ports use different pin connections, depending on the
chosen interface type. Select the Channel in column 1 then the desired
interface (RS-232, RS-422 or RS-485) in column 3. Wire the Methode
connector according to the pins listed on the associated table row.

Table 3-4 lists the cable interface data for the serial inputs and outputs,
and the rear port for Craft maintenance (P5). Figure 3-7 diagrams the
serial port interface connections for direct connection or connection
through external modems.
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I Craft
| P5 (Chan 0)

0

Chan 1

~

P2 (Chan 9)

P1 (Chan 7)

6 P4 (Chan2) P3
% 2

12345678
EEEEEEER

RS-232/422/485

34567
EEEER

[ L
[_fee]

Not Used

RS-422/485| RS-232

Not Used

Not Used

RS-422

P13 (Chan 1) | P12 (Chan 1) | P11 (Chan 3) P10 (Chan 5)

feet) or unshielded (up to 1,000 feet).

Not Used

Not Used

| P9 (Chan 8)

P8 (Chan 6)

* RS-422/485 — Standard 2-pair (4-wire) twisted #24-AWG cable: shielded (up to 4,000

* RS-232 - Standard 3-pair (6-wire) #24-AWG cable: unshielded (up to 50 feet).

Figure 3-6  Rear View of WS2000 Serial Port Connectors (Methode)
Table 3-4  Cabling Interface Data for Serial Input/Output
Chan Conn I,gtsfc Methode Pin Number
1 2 3 4 5 6 7 8
P12 232 TX RTS | CTS | Com Rx DCD - -
1 o6 422 - - - Com Rx— Rx+ Tx- Tx+
485 RTS- | RTS+ - Com Rx— Rx+ Tx— Tx+
232 TX RTS | CTS Rx DCD - -
2 P4 422 - - - Com Rx— Rx+ Tx- Tx+
485 - - - Rx— Rx+ Tx- Tx+
232 TX RTS | CTS Rx DCD - -
3 P11 422 - - - Com Rx— Rx+ Tx- Tx+
485 - - - Rx— Rx+ Tx— Tx+
232 TX RTS | CTS RXx DCD - -
4 P3 422 - - - Com Rx— Rx+ Tx- Tx+
485 - - - Rx— Rx+ Tx— Tx+
232 TX RTS | CTS Rx DCD - -
5 P10 422 - - - Com Rx— Rx+ Tx- Tx+
485 - - - Rx— Rx+ Tx— Tx+
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Rx |« 1 (Tx)
Local Point-to-Point Local PC CTS |« 2 (RTS)
Connection (RS-232) Seoricj ot RTS » 3 (CTS) P12
Channels 1-5 (DTE) GND 4 (GND)
Tx » 5 (Rx)
Notes 1 and 3
P3, P4, P6,
Local Point-to-Point 180 W Ruct 8 () P10. P11
. Rx— 7 (Tx-) '
Connection (RS-422) Network o, » 6 (Rx+)
Channels 1 -5 Element » 5 (Rxo) 180 W
(DTE) d
Notes 2 and 3
N . Rx+ |« 8 (Tx+) P3,P4,P6,
etwork py— ¢ 7 (Tx-) P10, P11
Element ., 6 (Rx+)
DTE
(OTE) - _ » 5 (R 180 W
P WS2000 (DTE)
Local Multi-Point Network 2):: P
Connection (RS-485) Element Txt N
Channels 1 -5 (DTE) R
Tx—
N Rx+ [« >
Apply Termination
pply Terminati 18ow[ Ry e >

Resistor on Furthest
Network Element

Figure 3-7

Network
Element

(DTE)

Tx—

Serial Port Interface Connections for WS2000

The following notes are to Figure 3-7.

To Additional
Network Elements

Any of the WS2000 serial data collection ports and the host port
can interconnect to NEs using RS-422. The WS2000 is considered
Data Terminal Equipment (DTE). If the NE to be connected is
DTE, the WS2000 transmit signal lines terminate into the NE
receive inputs and the WS2000 receive signal lines terminate into

the NE transmit outputs (that is, transmit-receive crossover connec-
tion).

Five of the WS2000 serial data ports (Channels 1 —5) can intercon-
nect to NEs using RS-485. Connections are the same as for the
RS-422 interface. Observe that for a multi-drop RS-485 interface,
the end network element should have terminating resistors installed
for the channel receiver. Refer to paragraph 3.4.3.2.1 for
appropriate backplane strapping. Intermediate units do not require
channel termination.
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Common terminology for balanced line connections is plus (+) and
minus (=). Other naming conventions are as follows:

e Plus=tip (T)=A=true (T)
e Minus =ring (R) = B = false (F) = invert

3.4.4.4 Discrete Connections

WS2000 backplane connector J1 handles the cable connections for
discrete inputs. See Table 3-5 Pinouts for WS2000 Discrete
Interface Connector J1 for connector pin layouts.

The WS2000 SSMATE uses only the first 32 discrete points routed
through J1 backplane connection. J2 is used to route discrete inputs 33-
64 that may be used in future expansions of this WS2000 model type.

Figure 3-8 shows a rear view of the WS2000 with the connector
layouts.

To MDF or Network
_( Connector @ Element

IE EI To MDF or

( Connector Cable | Network

E_I Element

Figure 3-8  Rear View of the WS2000 Discrete Connectors

Connector

Cable

Delta 50-pin male connector. Use either of the following connector
assemblies:

e  Westronic 50-pin connector assembly: PN 620-0078
e Cinch: PN 97-12500-180 or 97-12500-181

Standard 25-pair (50 wires) unshielded telephone cable; #24 AWG sin-
gle-strand wire

Table 3-5 list the connections to the discrete interface connector, J1
located on the backplane.
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Table 3-5  Pinouts for WS2000 Discrete Interface Connector J1
Function Pin Function

Control Output 1, Not Applicable 1 | 26 | Control Output 1, Not Applicable
Control Output 2, Not Applicable 2 | 27 | Control Output 2, Not Applicable
Control Output 3, Not Applicable 3 | 28 | Control Output 3, Not Applicable
Control Output 4, Not Applicable 4 | 29 | Control Output 4, Not Applicable
Control Output 5, Not Applicable 5 | 30 [ Control Output 5, Not Applicable
Control Output 6, Not Applicable 6 | 31 [ Control Output 6, Not Applicable
Control Output 7, Not Applicable 7 | 32 ] Control Output 7, Not Applicable
Control Output 8, Not Applicable 8 | 33 | Control Output 8, Not Applicable
Ground 9 | 34 | Control Output Common Voltage
Status/Alarm Input 1 10 | 35 | Status/Alarm Input 2
Status/Alarm Input 3 11 | 36 | Status/Alarm Input 4
Status/Alarm Input 5 12 | 37 | Status/Alarm Input 6
Status/Alarm Input 13 | 38 | Status/Alarm Input 8
Status/Alarm Input 9 14 | 39 | Status/Alarm Input 10
Status/Alarm Input 11 15 | 40 | Status/Alarm Input 12
Status/Alarm Input 13 16 | 41 | Status/Alarm Input 14
Status/Alarm Input 15 17 | 42 | Status/Alarm Input 16
Status/Alarm Input 17 18 | 43 | Status/Alarm Input 18
Status/Alarm Input 19 19 | 44 | Status/Alarm Input 20
Status/Alarm Input 21 20 | 45 | Status/Alarm Input 22
Status/Alarm Input 23 21 | 46 | Status/Alarm Input 24
Status/Alarm Input 25 22 | 47 | Status/Alarm Input 26
Status/Alarm Input 27 23 | 48 | Status/Alarm Input 28
Status/Alarm Input 29 24 | 49 | Status/Alarm Input 30
Status/Alarm Input 31 25 | 50 | Status/Alarm Input 32
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Figure 3-9  620-T030 Wire-Wrap Rear Connector
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3.4.45 Terminal Board TB1 Connections
Figure 3-10 shows connections to TB1.

Normally Open @ @
MPU Run Relay Output Contact 2 1| —Battery (20 to 72 Vdc)
cammen | 4 ()| ()5 | soanaryee
MPU Run Relay Output Contact attery (Return)
Normally Closed 6 @ @ 5 Normally Open

MPU Run Relay Output Contact A/V COS Relay Output Contact
o Q)| D7 | s

A/V COS Relay Output Contact
10 @ @ 9 Normally Closed

A/V COS Relay Output Contact
12 @ @ 11 | AV COS Reset (+ Battery Pulse)

14 @ @ 13 | Chassis Ground

Use #14 — #24 AWG Solid Wire for All TB1 Connections

AV Audio/Visual

AWG  American Wire Gauge
COSs Change of State

MPU Microprocessor Unit

Figure 3-10 'WS2000 Rear Connector TB1

3.45 Powering the WS2000

The procedure to apply power to the WS2000 can vary, depending on
the equipment installed. The following describes how to apply power to
a WS2000 equipped without discrete expanders.
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Using #14 — #24 AWG power wire, connect input power to WS2000
TBL1 through a fused source. Table 3-6 provides fuse requirements. The
input voltage ranges from —20 Vdc to —60 Vdc. Verify that the plug-in
board assembly is installed and that the power input leads are
terminated before inserting the fuse.

Table 3-6  WS2000 Fusing Requirements

—-48 Vdc —24 Vdc

GMT Type 70 GMT Type 70

0.75A | 0.75A | 13A 1.3

Each WS2000 unit pulls a maximum load of 24 Watts, assuming all dis-
crete inputs are active and the WS2000 application includes a rack-
mount modem.

1. Install the appropriate fuse at the power distribution panel to power
the WS2000 up. The front-panel MPU RUN LED lights and remains
lit.

2. Connect a PC to the DB25 connector (JB3) on the WS2000 front
panel.

. CAUTION: Do not power down the WS2000 without first
disconnecting the PC unit connected to the front DB25 connector.
3.5 Installation Check List

Use the following check list when installing the WS2000 hardware:

A.  Mount the unit.

e  Verify strap options on the main board. Refer to Figure 3-3
and Table 3-1.

B. Verify backplane strap options (Figure 3-3) for the serial RS-422
receive side terminations (Z2, Z3, Table 3-2)

C. Cable the unit

e  Verify serial port connections (DTE/DCE or DTE/DTE):

e Figure 3-6 Rear View of WS2000 Serial Port
Connectors (Methode)

e Figure 3-7 Serial Port Interface Connections for
WS2000

e Table3-4 Cabling Interface Data for Serial
Input/Output

e  Verify discrete connections:
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e  Figure 3-8 Rear View of the WS2000 Discrete
Connectors
e Table3-5 Pinouts for WS2000 Discrete Interface
Connector J1
e Figure 3-9 620-T030 Wire-Wrap Rear Connector)
e  Verify power connections (Figure 3-10)

The unit is now ready for software configuration. See Section Error!
Reference source not found. for configuration information using the
CLI and Section 4 for using the SSMATE Configuration Software.
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4 SSMATE Configurator

This section explains the step-by-step procedures for installing and
using the WS2000 SSMATE Configurator software (567-T060)
supplied with each unit.

Configuring the WS2000 SSMATE can involve some or all the of the
following:

e  Starting the SSMATE Configurator application
Creating a database
Modifying an existing database text file
Uploading/Downloading a WS2000 database
Establishing the PC COM port
Configuring the WS2000 serial port settings
Resetting a port’s parameters
Configuring the ASCII strings for each point
Initializing ports and string blocks

4.1 Overview

The SSMATE Configurator is a user-friendly Windows 95/98 based
application with a Graphical User Interface (GUI) that enables you to
more efficiently configure a WS2000 SSMATE. Using the
Configurator provides these additional capabilities over using an ASCII
terminal and the CLI configuration tool described in Error! Reference
source not found.:

e View and Print the entire database contents from a single
PC window.

e  Change or modify a single point or port setting as well as
change the entire database with a single keystroke action.

e Upload a complete SSMATE database from the WS2000
SSMATE to the PC and save it as a .txt file.

e Load a previously saved database file and download it to
the WS2000 SSMATE.

e Use the SSMATE Configurator to generate a database
offline.
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Figure 4-1  Configurator Overview

To explain the interface between the Configurator software, database
files and the WS2000 SSMATE unit, Figure 4-1, with a little
explanation should clearly illustrate the relationships.

The Configurator software utilizes three separate locations to store and

retrieve database configuration files to and from. A brief description of
each will help explain the use of the commands described later. Figure
4-1 shows these memory locations:

1. Current Configuration file in PC Memory. Displayed as the
current configuration during the use of the SSMATE Configurator.

2. Saved Configuration (.txt) file located on PC non-violate memory
device i.e. floppy or disk file.

3. Hardware Configuration image located in the WS2000 EEPROM
memory.

The Configurator software can obtain a configuration database and
place it in the current configuration, either from the WS2000 SSMATE
by simply invoking the “upload” command or “load” a database file
from a PC memory device. The actions “Save” and “Download”
actions allow the storage of the current configuration to a file or the
WS2000 memory.
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When changes are made to the current configuration using the COM or
Configure drop-down menus, the program ask if you want to save the
changes before exiting the screen. This is only a reminder that you have
not saved the changes to the configuration file. To recap, the action
items that appear on several of the Configurator screens.

e APPLY Applies the changes made in the Configurator screen to the
current database located in PC resident memory
ONLY. This action does not save the configuration
to the WS2000 SSMATE or to a PC File

e DOWNLOAD Download the current configuration database in the
PC resident memory to the WS2000 SSMATE
memory

e CANCEL Disregard changes and revert to previous values
e SAVE Save current database to a PC memory device

e SAVE AS Save current database to a PC memory device and
input a file name

e OPEN Open a database .txt file and load into PC resident memory
as the current database

4.2 System Requirements

The SSMATE Configurator operates only under a Windows® 95/98
operating system on IBM 32-bit or compatible machines. The
Configurator application fits into a screen with a minimum resolution of
800 x 600, preferably higher.

The PC using the Configurator application requires the following:

e RS-232 serial COM 1 port
PC mouse. Can use the keyboard with the SSMATE
Configurator.
IBM 32-bit or compatible processors with Windows 95/98
Minimum recommended screen resolution of 800 x 600
Versatile PC Com Port selection
Automated Windows installation and uninstall functions
Ability to open tab- or comma-delimited SSMATE
database text file
Ability to save a tab-delimited SSMATE database text file
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4.3 Installing and Starting the WS2000 SSMATE
Configurator

Load the SSMATE Configuration program (567-T060) onto the
Personal Computer (PC) following normal Windows installation
procedures.

The Install Shield 5 installation development program automates
SSMATE installation. You only need to insert the installation disk and
execute the setup.exe file located on the disk.

The installation program will create a folder named “WS-TOOLS”
located in C:\WINDOWS\Desktop\WS-Tools. The folder will contain
the SSMATE Configurator and Uninstall SSMATE Cfgr shortcut icons.
These icons can be copied or moved as desired using normal Windows
procedures. Start either application by double-clicking the appropriate
icon

If the target PC already has other programs distributed by Westronic,
such as the WS2000 PC Wesmaint or the WS3000 TL1 Configurator,

the Setup program adds the Configurator to the existing WS-Tools
program group.

& CAWINDOWSA\Desktop\W5-Tools =1
J File  Edit “iew Go Favontes Help ‘
= O & g ”
Back b=anyand Up kap Drive
| Address ] C:AwINDOWS\Desktopti/S-Taks =]
JLlnks Cse JF ke Pt U=z =
SSMATE | Uninstall
Configurator SSM.-’-‘«T fori
|2 object(z] |_§‘ ty Compute 2

Figure 4-2 WS-Tools Desktop Folder

The Configurator connects to the WS2000 SSMATE front-panel Craft
port using the Wesmaint cable 977-T032 shipped with the Configurator.
If the cable is lost or not readily available, one can quickly be made
using the diagram illustrated in Error! Reference source not found..

4.4 Working with Databases

The WS2000 SSMATE is shipped with a default configuration database
stored in its memory (EEPROM). The first exercise the new user
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Figure 4-3

should do is to upload the default database and save it in a file labelled
“default DB.txt”. You will then always have a default database to go
back to in case a problem arises.

You can upload the current database from the WS2000 SSMATE to the
PC Configurator program and make modifications as needed, apply the
changes to that database file, then download the configuration to the
WS2000 SSMATE. As mentioned earlier, you can also save the
database as a text (.txt) in the PC memory device. Good record keeping
and file naming should be used in this process to avoid confusion in the
future.

You can create or modify a database configuration in an Excel
spreadsheet as a comma-separated (.csv) or tab-delimited text (.txt) file.
You can open an existing file with any spreadsheet application to
modify it, and then save it as a tab-delimited text file for future use.

The Configurator can import only files with *.txt” extensions. Figure
4-3 illustrates a portion of a configuration database file in MS Excel.

Ed Microsoft Excel - SSMATE_Cnfg_Cmds_Ext

J@ File Edit Wiew Insert Format Tools Data Window Help Acrobat

DS R 2R »- &z £ 4 aBEE 272
| ria -3 - BIrUEEEE _-»-A- 2
09 | =]
A [ B [ ¢ [ o [T E T F [ 6 I

1 |#vS2000 SSMATE COMFIGURATION FILE _I
2 |#PORT PROPERTIES

3 |#PORT SPEED PARITY DATA STOP INTERF &CE

4 1 1200 MOME g 1 232

5 2 Q600 EVEM 7 1 232

5] 3 QE00 MOME =] 1 232

7 4 4300 MNOME a 1 232

] 5 9e00 MOME =] 1 232

9 |#EMD PORT PROPERTIES a

10 |#POINT STRIMNG BLOCH OUTPUT PORT

11 [#POINT TO PORT

12 1 2

13 2 2

14 3 3
75 4 4 -
[4 [« » [M]"S5MATE_Cnfg_Cmds 4] | Wl
Ready |1 T e

WS2000 SSMATE Configuration Database file

4.5 SSMATE Windows

As a Graphical User Interface (GUI) application, the SSMATE
Configurator has several screens that enable you to easily configure the
WS2000 SSMATE.
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When you first launch the application the SSMATE Configurator
temporarily displays a “splash” screen (Figure 4-4) while it is loading
and checking PC COM Port 1 for presence of a WS2000 SSMATE.

& Westronic

SSMATE Configurator

@ Copyright 2001 Westronic Systems, Inc. All Rights Reserved.

Figure 4-4 SSMATE Splash Screen

If the SSMATE Configurator does not detect a working WS2000
SSMATE craft port on COM PORT 1, the following error screen is
displayed.

Communications Error E

Q SSMate Configurator could nat detect the prezence of a'wS2000 an PC COM Port 1

Common cause is a mismatch of the PC’s COM port 1 parameters.
They should be set to RS-232 at 9600bps, 8 data bits, no parity and 1
stop bit. Select “OK” to continue to work in the off-line mode. If a
different COM port than COML1 is used to connect with the WS2000,
refer to paragraph 4.5.2 to change the COM port selection.

Figure 4-5 illustrates how the main screen will appear if there was not a
valid WS2000 SSMATE craft port connected. The “CLI” selection in
the main toolbar is unavailable and will be greyed. The CLI selection
will indicate a valid craft port connection anytime one is made while in
this off-line mode. There is no need to restart the Configurator.
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Figure 4-5

45.1

File Menu

The SSMATE Configurator can operate in the off-line mode without a
WS2000 SSMATE unit connected to it. All functions will be operable
except the Upload and Download and the CLI commands. Refer to the
overview illustration in Figure 4-1.

After the SSMATE Configurator has loaded and completed its check of
COM Port 1, the SSMATE Configurator main screen appears (Figure
4-5). The main screen contains all the command menus required for
working with databases, setting up the PC communication ports, and
configuring the WS2000 SSMATE.

"2 SSMATE Configurator =] E1

File COM Configure £ Help

Indicates off-line
mode when greyed

SSMATE Configurator Main Screen

The figures that follow (Figure 4-6 through Figure 4-14) illustrate the
main toolbar command menus and sub menus.

The File menu (Figure 4-6) is the central control panel for the SSMATE
Configurator. The File menu contains all the command functions to
load a configuration database into the Configurator program from either
a file or from the SSMATE. The File menu also provides a means to
save the database on a memory device or download it to a SSMATE
unit.

The function of each command is described below.
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'z SSMATE Configurator

|File COM Configwe CLI Help
Open
Save
Save s

Upload
Download

E uit

Figure 4-6  File Menu Options

4511 Open:

This command opens a standard dialog screen that allows you to select
and load an existing WS2000 configuration database file into the
Configurator program. The SSMATE Configurator is expecting a
comma- or tab-delimited file with an extension of .txt.

The Configurator performs an error check on the file as it is loading. If
there are errors in the file, the Configurator will display and list the
errors in an Error(s) window as shown. The user is given the choice to
“COPY” the errors listed to the Windows Clipboard or close the screen.

'3 SSMATE Configurator =10 x|
File COM Configure CLI Help

"2 Configuration Eror(s]

CAMY DOCUMENTSI984-TOLAMODIFIED 15T UPLOAD TXT

Route Setting: Line 12 Error, Invalid Range Port Route—Using Default
alue
Route Setting: Line 13 Error. Invalid Range Port Route—Using Default
alue

COEY GLOSE | ‘

In this example the program is reporting an error on line 12 of the input
file. The error is an “Invalid Range Port Route”. The program will also
ignore this error and revert to a default value. Examining the input file,
the cause of the error is the entry “port 2 in the port column instead of

the correct entry “2”.
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45.1.2 Save:

This command saves the current configuration database text file to a
memory media support by the PC system. If the file began as a comma-
delimited text file, the application saves it as a tab-delimited file. If the
file is one that you created (did not open as a text file), the command
automatically functions as a “Save As” command.

45.1.3 Save As:

This command opens a standard dialog screen requesting a new file
name and location to save the current configuration database text file to.
If you select the same name as that previously opened, the application
returns a warning window. You are warned that the file already exists
and gives you the option of replacing it or aborting the command.

45.1.4 Upload:

This command retrieves a WS2000 SSMATE database from a WS2000
connected to the PC, usually through COM Port 1, and loads the
database into PC RAM for editing. The Upload command is available
only when the PC can communicate with a WS2000 SSMATE via
COM port 1. Otherwise, the command will be greyed out.

If there is an error uploading the configuration from the SSMATE the
following error message will appear and the upload will be aborted. In
the following example the greater-than character “>" was present in a
text string.

SSMateClar |

Q Errar retrieving information for point 8 Abarting wpload

For a closer examination of the SSMATE configuration you can use the
built-in Command Line Interface tool set explained in paragraph Error!
Reference source not found. found on page Error! Bookmark not
defined..

4515 Download:

This command sends the current configuration stored in PC RAM to a
WS2000 connected to the PC, usually through COM Port 1. The
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Download command is available only when the PC can communicate
with a WS2000 SSMATE connected to the PC. Like the Upload
command, the download command will be greyed in the off-line mode.

45.1.6 Exit:

This command terminates the SSMATE Configurator application. If
you apply this command when you have not saved the current
configuration, the application presents an error message.

45.2 Select the PC COM Port Menu

From the COM menu (Figure 4-7), you can select the PC COM to use
to connect to the WS2000 SSMATE. The default port is COM Port 1
when the SSMATE Configurator boots up. Change the selected PC
COM port properties, such as data rate, number of data and stop/start
bits, and parity using the Properties selection.

" SSMATE Configurator =] E3
File | COM Configure CLI Help

COmM1
v COMZ
CoM3
COM4
NOMNE

Properties

Figure 4-7 PC ComPort Selections

45.2.1 COM1 — COM4:

These choices allow you to temporarily select the PC COM port 2, 3 or
4 to connect to the WS2000 SSMATE unit’s craft port. COML1 is
always the default setting at program start-up.

A check mark beside the COMX selection indicates the selected port.
During boot-up, the Configurator tests Port 1 for the presence of a
connected WS2000 SSMATE and, if one is not present, it sets the COM
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setting to NONE and disables (grey out) File > Upload, File >
Download, and the CLI menu. When a valid COM port selection is
made and the Configurator senses a SSMATE craft connection, the
Configurator enables the CLI and File menu items.

45.2.2 NONE:
To disconnect the Configurator from the SSMATE and work offline,
select NONE

45.2.3 Properties:

Use this selection to set the selected PC COM port to 9600bps, 8 data
baits, no parity and 1 stop bit. Refer to Figure 4-8 for a screen sample.

.. SSMATE Configurator = O] %
File COM Configure CLI Help

. CommPort Properties

Pt Il:gmz vl
— Marimum Speed = EChio
= ak |

ISEDD "I [l i Cancel

Default |

— Connection Preferences = Elewi Eartral

Data Bits: I I & Hone

{0 nnatt

g -
Parity: INDne vl ~ BTS
Stop Bits: |1 vl {= o/ HiS

Figure 4-8 COM Port Properties

The WS2000 SSMATE craft port parameters are not configurable from
this or any other screen. The WS2000 Craft port is always set to
9600bps, 8 data bits, no parity and 1 stop bit.

4.5.3 Configure Menu

Use the Configure drop-down menus to set the port and string settings
of the WS2000 SSMATE. From the Configure menu (Figure 4-9),
select the Configure Port Settings or the Configure Point Strings
screens. Only one selection can be opened at a time.

994-T059 Rev March, 2006 SSMATE Configurator 4-11



.. SSMATE Configurator _|O) =

File COM | Configure CLI Help

Port Settings
Paint Strings

Figure 4-9  Configurator Menu

The Port Settings and Point Strings screens are illustrated on the next
page.

Reminder: When a change is made to a port or a string and the screen is
terminated before the configuration is saved, the following message will
appear:

Databasze Mot Saved |

& Ywarning Database not zaved, Continuing may cauze loss of data. Continue Anpwiay?

A response of “Yes” simply closes the screen with the values of the
current configuration remaining intact. If the program is terminated
before the File > Save command is invoked, there is no permanent file
of these latest changes. If Download is selected from either screen, the
changes are loaded to the WS2000 memory. Following Download, the
upload command can be used to restore the latest changes.
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4531 Port Properties:

This command loads Configure Port Settings screen (Figure 4-10). This
screen is used to set the serial port parameters for ports 1-5 of the
WS2000 SSMATE. Configurable parameters are port speed, data rate,
parity, stop bits and signalling service.

“." SSMATE Configurator

(=] ES

File COM Configure CLI Help

“.” Configure Port Settings | x|

Port 1 IF'Drt 2| Part 3| Fart 4| Port 5|

—Fort Properties

Bitz/Second ISEDD I Apply |
[iata Bitz Download I
Parity LCancel I

Stop Bits

Signaling RS |232 I

Figure 4-10 Configure Port Settings Screen

Select Port 1 through Port 5 tags. Once a change is made to a port you
will be prompted to save the new setting before proceeding to a new
port or exiting the Configure Port screen.

Databaze Not Saved E2

& W arming Database not zaved, Continuing may cause loss of data. Continue Angway?

Use the “Apply”, “Download” and Cancel” option buttons to:

Apply The current settings to the Current Configuration
settings
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Download Download the current settings to the WS2000 SSMATE.
You will be prompted to reset the SSMATE port for the

Port Rest |

@ Reset Paort? Paort must be reset for changes o take effect

changes to take affect. This command also invokes the
Apply selection.

Cancel Cancel changes and revert to previously set values. The
settings for the currently displayed port will return to the
previously set values. The screen will display these
values.

Reminder: The values set in this screen are loaded to the WS2000
SSMATE unit when the Download selection is made. The
Reset Port command must be invoked before the changes
take affect on the WS2000 ports.
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45.3.2 Point Strings:

This command opens the Configure Point Strings screen (Figure 4-11).
Select points 1-32 by mouse clicking the appropriate tab. View or
modify the five text strings and make port assignments for the string
block to be sent from. In the following example the 5 text strings will
be sent out port 2 of the SSMATE unit when point 1 becomes active
(grounded).

"' SSMATE Configurator =]
File COM Configure CLI Help

. Configure Point Strings [ %]

point 24 I point 23 I point 22 I paint 21 I point 20 I point 19 I point 18 I paint 17 I paoint 16
paint 15 I paoint 14 I point 13 I paint 12 I paint 11 I point 10 I point 3 I point 8 I point 7 I paint B
paint 32 I point 31 I paint 30 I paint 239 I paint 28 I point 27 I paint 26 | paint 25
paint 5 I point 4 I paint 3 I point 2 point 1
—aitring Block for Faoint 1

String 1 |u 1 z 3 4 [3

— Route To——

i Part 1
&+ Part 2
" Part 3
" Poit 4
" Paith

Slling 2 |1234557890123455'?3901234557390123455789014345

String 3 |mcn:rsﬂ1mm0?@nsrmvz AECDE FEH IJHLMHOT OR5

String 4 ITU‘i.mD{YZABCDETGHIMINDPQRSTWYZ-EHD 0F TEST

String 5 |»~ V1EZEIFARETEETFEIIN0_~+={ [ 1: [ '<7, ./ |

Figure 4-11 Configure Point Strings Screen

Use the “Apply”, “Download” and Cancel” option buttons to:

Apply The current settings to the Current Configuration
settings

Download Download the changed string(s) setting to the WS2000
SSMATE. This command also invokes the Apply
selection.

Cancel Cancel changes and revert to previously set values. The
settings for the currently displayed port will return to the
previously set values. The screen will display these
values.
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4.5.4 CLI (Command Line Interface)

The selections on this page parallel the CLI commands described in
section 4.

From the CLI (Command Line Interface) menu (Figure 4-12), you can
select the Version, Port Reset, and Initialize WS2000 SSMATE CLI
commands. These commands present a screen relevant to the command
that shows the command response from the WS2000 SSMATE. While
in these screens, you do not have direct access to the WS2000
SSMATE.

", SSMATE Configurator

Fie COM Configwe | CLI Help
Wersion
Port Rezet »
Initialize 3

Figure 4-12 CLI Menu

4541 Version:

This command displays the WS2000 SSMATE Command Line
Interface screen displaying the software revision level loaded into the
WS2000 SSMATE.
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" SSMATE Configurator O] x|

File COM Configure CLI Help

" WS2000 SSMATE Command Line Interface I
—Command

lssued: [WERSION
Fesponse:

563-T120%erl 1, 'WS2000 SSMATE REMOTE 06-27-20M
SSMATE:

4542 Port Reset:

This menu item sends a Reset Port command to the WS2000 SSMATE
with the same affect explained in paragraph Error! Reference source
not found.. found on page Error! Bookmark not defined..

" SSMATE Configurator O] x|
Fil= COM Configure | CLI Help

YWersion

Al Parts

From this menu, Ports 1 through 5 or All Ports can be reset to the values
downloaded from the Set Port screen. The following screen is returned
when Reset Port 4 is selected.
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"' SSMATE Configurator M=l E

File COM Configue CLI Help

S WS2000 SSMATE Command Line Interface I
~Cammand

lssued: |RESET PORT 4
Response:

COMPLETE
SSMATE:

45.4.3 Initialize:

This command returns the ALL port settings, All string settings, or both
to the factory default settings. See Figure 4-13.

" SSMATE Configurator _ O] x|
File COM Corfigue | CLI Help

Werzion

Port Rezet »

Strings Blacks
Al

Figure 4-13 CLI Initialize Ports

The program will request a verification to affirm that the Initialize
command is indeed what you want to do. Respond by mouse-clicking
the “OK” or “Cancel” selection.

Databaze Overwrite

Thiz command will dezstroy any configured changes inWS2000 SSMATE and return selected databaze zechion to
default state

Cancel |

4544 Initialize Ports
Following the Initialize Ports command the SSMATE unit will reboot.
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“." SSMATE Configurator
File COM Configure CLI Help

“'WS52000 SSMATE Command Line Interface | X|

=] E3

—Command

[zsued:

[INIT PORTS

Fesponse:

IMIT COMPLETE..REBOOTING

4545 Initialize String Blocks

Initializing the String Blocks does not invoke a reboot upon completion.

" SSMATE Configurator =] Ei

File COM Configure CLI Help

" 'WS2000 SSMATE Command Line Interface E3

—Comrmand

Issued: [INIT STRIMGS

Fesponse:

INITIALIZING
SSMATE>

IMIT COMPLETE

4.5.5 Help Menu

The Help menu gives you access to various Help topics related to the
WS2000 SSMATE Configurator. Use the “About” to display the
version of the Configurator running on your machine.
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. SSMATE Configurator
File COM Configure CLI | Help
Help Topics

About

Figure 4-14 Help Menu
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